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Limited Warranty Agreement
ALLEN DATAGRAPH i-TECH cutters are warranted to be free of defects in both materials and
workmanship. Should any part of this equipment be defective, it will be repaired or replaced, at the
option of the manufacturer, at no charge for parts or factory labor for a period of two (2) years from
the  date  of  installation.  All  warranty  services  are  performed  at  the  Allen  Datagraph  factory.
Replacement parts not installed at the factory will be billed to the customer at regular prices and
credit will be issued when the defective parts are returned. The customer is responsible for freight
on warranty parts and repairs.

This warranty is void if:

1. The equipment has been damaged by negligence, accident or mishandling, or has not been
operated in accordance with the procedures described in the operating instructions; 

or:

2. The equipment has been altered or repaired by other than an approved service station or
factory service center, or adaptations or accessories have been attached to the equipment that shall
have adversely affected the performance, safety, or reliability of the equipment.

NO OTHER WARRANTY, EXPRESSED OR IMPLIED, APPLIES to the equipment. Allen
Datagraph  does  not  assume  any  responsibility  for  consequential  damages  occasioned  by  the
equipment, or inconvenience or interruption in operation.

In case of unsatisfactory operation, Allen Datagraph or its Dealer should be notified immediately.

Service Policy
Please  refer  to  the  service  policy  on  our  website  at  the  link  below:
http://allendatagraph.com/techsupport/ServicePolicy.pdf

Technical Support
Up to 4 hours of call in technical support is available at no charge during the warranty period.
Technical support is available during business hours based on Eastern Time Monday thru Friday.
Technical support outside the limits stated will be billed at current rates. 

For Technical support submit a support ticket at http://allendatagraph.com/tech-support/ 

There are many online documents available to help you to use the Cutter at our technical support
page at  http://www.allendatagraph.com. Mouse over the tech support  link and select  download
drivers and documents.

Installation
SET-UP

Some Allen Datagraph products require specialized installation in order for the limited warranty to
remain in effect, ask your dealer or contact technical support at Allen Datagraph for details.

Unpack all accessories and the unit. 

Power Connection
Important Note:  Use of a HIGH QUALITY surge protector or uninterruptible power supply is
REQUIRED by Allen Datagraph Systems. Failure to do so could affect your warranty coverage if a
problem arises due to improper power connection.

CAUTION: The power cord is a three-conductor cable that incorporates a safety (earth) ground
connection. For the machine to operate safely and correctly, the power cord must be plugged into
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an outlet that has an earth ground contact.  Never plug the power cord into a two-prong outlet by
using a 3=2 cord adapter. 

CAUTION: Never allow roll or sheet goods to rub on the power cord because the material can cut
the cord causing an electrical fire hazard!

Allen Products except  hot  tip can be configured to operate from any power source capable of
handling 100-240 VAC / 47-63 Hz @ 250 Watts.  The Allen Hot Tip requires a power source
capable of handling either 100-132 VAC or 180-240 VAC / 47-63 Hz @ 300 Watts.

i-TECH Cutter Stand 
The i-TECH CUTTER comes equipped with a deluxe stand. Assembly instructions for the stand
are packaged inside the stand box that arrived with your cutter.

Note: The material rollers and associated brackets are packaged inside the cutter box, under the
packaging foam. It is necessary to remove the foam in order to remove the parts.

Computer Connection
System Interfacing

All  Allen  Datagraph  products  utilize  either  USB  (universal  serial  bus)  interface  or  Ethernet
connection. If you want to read about using the Ethernet port for the cutter see the document below
Website Copy / CD Copy.

The Cutter comes with a software installation CD that walks you through the installation of the
software on the computer you are using. Do not connect any cables or power cords until asked to
do so by the installation CD.

NOTE : If you plug in the USB before the driver is installed the USB driver may not be installed
correctly.   See  "USB  driver  repair"  if  you  did  this  before  you  read  the  instructions.
http://allendatagraph.com/techsupport/i-TECH/AdsiDriverInstallation.pdf / CD Copy.

If you do not have the CD you may download the cutter driver and install it from this page. Choose
latest  version.  http://allendatagraph.com/tech-support/online-documents/tech-support-
library/software-support/. Then download and install the remote panel program from this page: 
http://allendatagraph.com/techsupport/graphiclink.html.

If you are using AllenCAD you may download latest version from: http://allendatagraph.com/tech-
support/online-documents/tech-support-library/software-support/.   To  download  other  Technical
support  bulletins  go to  http://allendatagraph.com/ Mouse  over  the  tech support  link  and select
download drivers and documents. Once you have registered with the web site it will send you the
password  for  thee  DOWNLOAD our  CURRENT LIBRARY of  ONLINE DOCUMENTS and
DRIVERS link.

Loading Allen i-TECH Software
The Firmware Utility CD installs:

1. The Remote Panel Utility program for managing machine settings.

2. A current revision of firmware.

"Firmware" is software that controls the machine functions.  The
firmware on this disk is provided for update purposes only and
should not be installed on new machines.

3. Manual and sample jobs.

4. Cutter driver for Windows 10, 8.1, 8, 7, or Vista.
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Windows 10, 8.1, 8, 7, or Vista DirectCUT Driver
This printer driver has been tested with CorelDRAW (version 10-x8), Adobe Illustrator (version
10-cc  2017),  Flexisign,  Inkscape,  and  DraftSite.  It  should  work  with  any program that  sends
vectors rather than bitmaps to the printer. Allows cutting directly from windows graphics programs
without  requiring  additional  software  purchases.  Note:  Driver  requires  ownership  of  Allen
Datagraph Equipment to use. Requires: Windows 10, 8.1, 8, 7 or Vista.

Software Updates
Software updates after the product ships will be available on the tech support section of the 
http://allendatagraph.com/techsupport/graphiclink.html web site. If you are updating firmware it is 
recommended that you do this when you have a lull in production, as any issues during installation 
may cause delayed production.

To update to a later version of software when recommended to do so by the tech support depart-
ment, go to the web site. Click on tech support, then online documents.

Select your cutter type, AllenCAD or Cutter driver from list of selections.

Find the software update and click on it to download the setup program from the web site.

Installation instructions for the software are on the same page as the software.

Using Your Cutter
Install knife Blade in Holder

1) Remove the knife blade from the packaging

2) Remove the plastic cap on the knife blade

3) Drop the blade point out into the hole in the black plastic cap 
of the blade holder.

Install Blade Holder in Machine
Place the blade holder into the housing on the left side of the carriage, with the blade pointing 
downwards. Ensure the blade holder is fully seated in the housing. Tighten the thumb screw.

Load Media
Load media using procedures described in Appendix C.

Setting Force / Velocity
The cutter is shipped with the default power up setting suitable for
the type of material that is expected to be used based on the model
of the machine. You should reduce speeds/accelerations for heavier
materials. Start with force = 20 (use force up/down buttons) and
speed = 66% (use speed up/down buttons). Press the test cut button
on the home/controls screen. This draws the test cut. Use analog joy-
stick or the joy stick arrows on the controls screen to move the car-
riage away from the cut area. If you cut through the media backer,
reduce the force. If you cannot weed the media, increase the force. If
the material slips between the grit roller and the pinch wheels, use
slower accelerations. Spring pressure can also be changed by using
alternate springs shipped in the accessory kit.

Sending Job
Summary

1. Ensure the cut strip is in for cutting and removed for pouncing.
2. Install knife blade in blade holder.
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3. Ensure the blade is exposed beyond the blade depth guide (black plastic cap on the
blade holder).

4. Load material (Appendix C Loading).
5. Install knife assembly.
6. Set machine to CUT MODE.
7. Perform test cut.
8. Adjust force, offset and blade depth guide.
9.  Joy stick to where you want the lower right corner of the job to be on the media. 
 
CAUTION: To avoid personal injury, keep hands, hair, clothing and jewelry away from
the cutter's moving parts at all times.

Illustrator / CorelDraw
Select on layer in layer menu or object manager that contains information you want to cut.

From Illustrator or CorelDraw click on File -> Allen DirectCut.

Select cutter driver in drop down between Properties and Cut button.

Click on Cut.

AllenCAD
Click Tile and print. Select objects and press enter key.

Click ok on options page

Select cutter driver in drop down between Properties and Cut button.

Click on Cut.

Omega Composer / Signlab / Flexisign
See http://allendatagraph.com/tech-support/online-documents/tech-support-library/cad-software-re-
lease-notes/

Operation of the i-TECH SmartMark System
Optional SmartMarkTM Sensor 

The SmartMarkTM option that is available for Allen i-TECH cutters is an optical registration system
that allows cutting of pre-printed graphics. The SmatMark system has the capability of recognizing
up to three registration marks, and adjusting for scale and skew discrepancies that may occur.

The SmartMarkTM option consists of an eye sensor that is mounted to the cutting head.

The SmartMarkTM sensor recognizes changes in contrast from the background media to the printed
mark. The “sensitivity” of the sensor must be set in order for the system to recognize the contrast
reliably and be able to cut accurately.

Setting Up Your Label Job
The target should be a black rectangle on white media or a
contrasting color to background. See colors in Web Site Copy
or CD Copy. The recommended Mark Size is 0.5 inch (12
mm). When using the SmartmarkTM on a cutter you normally
need at least two marks as it is difficult to get media loaded
straight and printers to print the correct size in the x axis
(length-wise) of the printer. The sensor relies on reading the
change in intensity of the reflection of the red LED pointer, or
the contrast between the mark and media background. When
printing process colors on white media the best color for a tar-
get is usually black. Certain spot colors are difficult. For exam-
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ple silver spot on white, while to the eye there is contrast the reflectivity of the two is sometimes 
nearly the same. If there is trouble detecting the target you can print the target in a yellow or white 
field. The size of the yellow field should be larger than the scan length. (Note: in order to get an 
accurate scan no other printed marks may appear in the yellow scan area. The printer color align-
ment marks can appear on the inside edge of the target or the other side of the media.)

The mark should be placed at least 0.5 inches (12 mm) from the
edge of the media and the spacing between frames should be at
least 0.5 inch (12 mm). (Advanced usage: You can place the
target closer to the edge of the material if you use inside out
scanning. Change scan directions to inside out using front panel
buttons Settings → SmartMark Settings → Scan Direc-
tion.

Explanation of SmartMark
SmartMark  is a cutting edge system designed by Allen Datagraph sys -
tems to be used in the label cutting industry. It is specifically made to en-
sure incredible levels of both accuracy and compensation for printing er-
rors. This system allows an Allen Datagraph cutter to perform with excel-
lence where other machines may fall short as a result of an error in print-
ing or less-than-perfect machine tracking setup by the operator. 

The SmartMark  system relies on the contrast between the media background and the SmartMark   
mark. With these marks, it is able to establish an origin position for the cut file, and, when using 
multiple marks, can also find the skew or size error of a frame and automatically make the adjust-
ments necessary to ensure smooth operation. 

Starting a job on a SmartMark  equipped machine is as easy as positioning the red LED at the ori -
gin (top right) mark of the frame, and sending the cut file to the machine. 

Types of SmartMark
Scanning

There are five types of SmartMarkTM scanning
available. They are shown in the image to the right.
The scan type is selected in the printer driver pref-
erences.

Origin Skew, Origin Skew Scale, and Origin Scale
are the only types normally used on the cutter.

Origin Skew is used if the media is not necessarily loaded straight. This scans the origin and the 
skew mark and rotates the cut image to match the cut location at the two scanned locations. No 
scaling of the cut image is performed with Origin Skew scanning. If you cuts do not match in size 
from the print you either have to calibrate to printer or use a different find origin type.

Origin Skew Scale does alignment at the origin, rotation and scaling in both x and y axes are pre-
formed. This scan type requires that the sensor size parameter be correct so that cut image is same 
size as printed image. 

Origin Scale does alignment at the origin, rotation and x-axis only scaling at the scale point. It as-
sumes that the scaling in the y-axis is correct. If the printer you are using has a x axis scaling error 
you can normally correct this either in the printer or you can use calibrate to printer to get the cutter
to cut the same size as the printer.

Origin Only is not normally used on cutter because its is hard to load media straight. Origin only 
does a alignment with the visual sensor at the origin only.
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Edge is not normally used on cutters. By selecting EDGE in the driver's printing preferences menu,
the SmartMark sensor will detect the edge of the media instead of a registration mark, then offset 
into the media by that amount and cut your blank labels. 

Designing Labels
Planning Label

This tutorial will design a large contour cut of a photo of a duck 26 x 10 inches (66 x 25 cm) label 
for a printer and an i-TECH cutter with SmartMarkTM with CorelDraw and Illustrator. 

Now that we have work space planned choose program to design your artwork. The image I used 
was found on the internet at http://twilightearth.com/environment-archive-2/there-is-this-duck-that-
i-have-lunch-with/. Right click on the image and save it.

Using Adobe Suite Tools
Open photoshop and crop, magic wand and trim using laso tool to erase water near duck. No need 
to be real accurate as we will create a cut line that trims the duck the way we want it to appear.

save image as duck no water.jpg

Use image -> size change height of image to 10. This makes the width about 22 inches.

save image as duck bigger image.jpg

Open Illustrator and create a new document.

Change units to inches

Change width to 28 and height to 11

Click ok

Click on view -> rulers if rulers missing

Click on window -> layers if layer menu missing

Click on window -> color if color menu missing

Now create two layers. One called “dielines” and one called “print”. This is done from the layer 
window. Click on new layer button. Then rename the layers as dielines and print by double click-
ing on layer name, changing name and clicking on ok.

Next create the die lines. Click on the dielines layer on the layer window.

Create the die line for the target

Select dielines layer

Click on file place. select duck bigger image.

Click on drop down arrow next to live trace button. select tracing options,

Select threshold of 254 and blur of 2 px, click on ok. Wait for trace to complete. then click on ex-
pand to move outline to dielines layer.
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Click on object, path, simplify. Set curve precision to 10 and angle threshold to 10

Next click on the print layer

Click on file -> place and select duck bigger image.

From the ruler drag a guide line for left, right and bottom and place the guide line close to the print-
ed image.

Set fill to black and outline to null.

Note: if you have a stroke on the edge of the printed target the print and cut will not line up.

Select rectangle tool

Click near lower left intersection of the guide lines.

Select size 0.5, 0.5 for size, click ok

Zoom in to target only

Move target so that left and bottom of target are touching guide lines.

Repeat for lower right intersection placing target so that right and bottom of target are touching 
guide lines.

Lock the print layer so you don't accidentally move it during editing of path.

Clean up the path using path edit tools.

Add 1/2 inch rectangles for origin and scale on the dielines layer. The targets must be in same place
on print and dielines layers. These rectangles should have strokes and not filled.

This completed label file is at this link Web Site Copy / CD Copy.

Use File -> save to save the file on your hard drive as big duck.ai. Using a color printer print im-
age..

To send dielines to cutter, click on dielines layer to select it and then click on

  File -> Allen DirectCut.

Using Corel Suite Tools
Open Corel photo paint and crop and trim using magic wand, freehand mask tool to erase water 
near duck. No need to be real accurate as we will create a cut line that trims the duck the way we 
want it to appear.

Save image as duck no water corel.jpg

Use image -> size change height of image to 10. This makes the width about 22 inches.

Save image as duck bigger image corel.jpg

Open Corel Trace

Open duck bigger image corel.jpg

Select advanced trace

Select max colors = 2, node type = smooth, minimum object size = 100, click on do trace

Save as duck bigger image corel.cmx

Open coreldraw and create a new document.

Open CorelDraw, Select -> tools -> options -> work space.  Place a checkbox in front of Allen 
Datagraph.

Next turn on 2 dockers: Select Window -> Dockers ->
Properties

and

Window -> Dockers -> Object Manager

Verify snap to guide lines is checked from the view menu.

This adds two control windows on the right side of the program
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Change units to inches

Change width to 28 and height to 11

Click ok

Now create two layers. One called “dielines” and one called “print”. This is done from the layer 
window. Click on new layer button. Then rename the layers as dielines and print by double click-
ing on layer name, changing name and clicking on ok.

Next create the die lines. Click on the dielines layer on the layer window.

Create the die line for the target

Select dielines layer

Click on file import. select duck bigger image.cmx.

Next click on the print layer

Click on file -> import and select duck bigger image.jpg

From the ruler drag a guide line for left, right and bottom and place the guide line close to the print-
ed image.

Set Paint bucket = solid fill black and pen nib outline to none.

Note: if not have a pen nib outline on the edge of the printed target the print and cut will not line 
up.

Select rectangle tool

Draw small rectangle of any size near where you want it.

Change size of rectangle to 0.5, 0.5 while rectangle is selected.

Zoom in to target only

Move target so that left and bottom of target are touching guide lines.

Repeat for lower right intersection placing target so that right and bottom of target are touching 
guide lines.

Lock the print layer so you don't accidentally move it during editing of path.

Set Paint bucket = no fill and outline to hairline and color black.

Add 1/2 rectangles for origin and scale on the dielines layer. They must be in same place on print 
and dielines layers.

Clean up the path using path edit tools.

This completed label file is at this link Web Site Copy / CD Copy.

Use File -> save to save the file on your hard drive as duck coutour.cdr.

To send dielines to cutter, click on dielines layer to select it and then click on 

  File -> Allen DirectCut.

Lining up SmartMarkTM

Use the buttons around the select key to move the carriage left,
right, forward, backward until the led pointer is within 1/8 inch
(3 mm) of right front of the target.

Sending file with Illustrator
Load the file you want to cut with Adobe Illustrator. If the layer
window is not visible you can make it visible by clicking on
Window -> Layers. Select the dielines layer on the layer menu. Click on File -> Allen DirectCut to 
open the DirectCut for Illustrator.
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Sending file with CorelDraw

Load the file you want to cut with CorelDraw. If the object manager is not visible you can make it 
visible by clicking on Window -> Dockers -> Object Manger. Select the dielines layer on the ob-

ject manager tab. If the Allen DirectCut tools  does not appear near the view button, select 
Tools -> Options -> WorkSpace. Then check Allen Datagraph. Click on the Allen DirectCut button
to open the DirectCut for CorelDraw preview window.

Find Origin Type

Verify the cutter you want to send the die lines to appears
in the drop down box between the Cut and Properties but-
ton. Click on the properties button and select find origin
type you want to use. Select origin scale, or origin skew
scale for Find Origin type.

Rotation 

In the preview window select Cutter origin. This moves the
origin to the lower right on the screen. This matches the
view you see when you look at the front of the cutter. Use
the rotate selection in the properties until the origin of the
preview is in the upper right. Select rotation from (none,
90°, 180°, or 270°). 

Cutting Label
After you have set the properties click OK to close property
window. Then click on the Cut button to send the job to the
cutter.

Smart Mark Setup
See calibration  procedure at  Web Site  Copy /  CD Copy
available  on  the  technical  support  page  of  the  Allen
Datagraph  web  site  at  http://www.allendatagraph.com ->
mouse over tech support → download drivers and documents -Download our Current Library of
Online Document  – sign making → smart  mark cutter  → smart  mark  cutter  technical  support
bulletins → SmartMark Sensor Page.

Control Panel
Home Page

The front control panel is the primary user interface for the
i-TECH cutter. It is used for input of speed and force as
well as several other functions. 

LOAD 
The load key is used to initialize the system and to load the
media. If the load key is red and displays LOAD you have
to press the load key.  Once the material is fed thru the
media path and the nip rollers are engaged (see Appendix 
C Loading), press the load. If the media height sensor is
off, the load button will be green and show READY to
indicate the system is ready to operate. If the media height
sensor is turned on, the system will scan the cutter station
pinch rollers to determine the media width. 
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PAUSE 
The pause key will halt the operation of the system at any point. It is used to pause the system for
inspection, media jams or to pause the machine for any other reason. Press the pause key to resume
the system. The system can be jogged while paused and will remember where it was and resume
from where it was stopped regardless of where it was jogged. This is very helpful for inspecting the
cut. You can pause the system and joystick the media or cut head away from its position to inspect
the cutting or registration. After inspecting the media, simply press the pause key again and the i-
TECH will return to the point where it was paused and resume cutting. The pause light will flash
while the system is paused. You can also use the pause button to enter the unload state (press Pause
followed by Load).

COPY 
The copy key is used to input the quantity of copies the i-TECH will cut. It is used after the first
copy of the job is cut. Once the first copy is cut and you are happy with the results, press the copy
key. Enter the number of copies you would like or ∞ for the number of copies desired. The number
represents the total number of copies to make.  

SPEED 
The speed keys  are  used for  controlling the cut  speed (the speed the knife travels around the
periphery of the items being cut). Increase the speed by pressing the up arrow key. Decrease the
speed by pressing the down arrow key.  Press on the number itself to enter any speed with the
keypad. 

FORCE
 The force key is used in conjunction with the test cut key to set the depth of cut. The factory
default for cutting is set by the value saved in setting #1. 

The force is set by test cutting the media to be cut using the test cut function. Using the joystick,
position the knife in an unused portion of the media and press the 

TEST CUT 
key. The system will cut a test cut pattern similar to the diagram to the right.
With a sharp knife or tweezers you should be able to individually remove
each part of the test cut pattern working from the ring to the triangle without
affecting the remaining parts. A properly set force will leave a very slight
scratch or mark on the liner.

The force may need to be adjusted due to blade wear during use if problems with weeding occur.
Simply increase the force setting by one until satisfactory weeding occurs. If the knife blade is
changed, revert back to the original setting or perform the test cut procedure again. The blade may
need to be replaced if the force is increased by more than 20 percent from when the blade was new.

Cancel
Select RESTART CUTTER to restart the cutter

Select CONTINUE to resume cutting

Select  CANCEL  JOB  to  stop  the  current  job  from  running
without a restart.

JOYSTICK 
The joystick is used for positioning the knife and media in the
cutting station and for several other functions. You can also use the joystick on the
left pod of the cutter.
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The four ARROW KEYS are used to jog the material or cutter carriage that holds the knife blade
and the SmartMark sensor.  Use the  Joystick Speed button to set the joystick speed. Press and
hold the arrow keys to move the carriage.

Red  exclamation  point  Icon.  This  will  displayed  if  a  error  occurs.   This
notification is set once and saved through power cycle and must be reset to clear
the red exclamation point icon.  To display the error, touch the red icon and read
messages in the about box on the last error message.  To clear the error flag, touch
the red exclamation point, touch menus, enter 2, 5, enter. Then touch clear error
message button.

SETTINGS 
Displays the settings pages.  Some buttons will not show up unless your are
in advanced menu mode or have the SmartMark Settings set to on, on the
user parameters menu.  To turn on the missing buttons click → About →
User Settings → Menu Settings → 25 → enter.

Settings
Cutting Parameters

Cut Speed - 

displays and sets the velocity of the knife when it is actually
drawing or cutting.  The draw speed is  the speed the knife
travels around the periphery of the items being cut

Move Speed

Move Speed displays and sets the velocity of the knife when
it is moving and not touching the media. 

Force 

Force controls the blade pressure 1% is about 10 grams of
force and 100% is about 550 grams of force

Mode

Mode sets the operation. Select cutting, pen plotting/drawing
or pouncing. The i-TECH will normally default with the cut
function.

Acceleration
This  allows  setting  the  acceleration  in  0.25  G  increments.
Acceleration is the rate of increase/decrease of speed of the motors along a vector. Higher G values
increase  throughput  however  higher  G  values  also  increase  the  likelihood  of  experiencing
repeatability problems. Recommended values are (1-2) for standard media. Use lower values for
heavy media  (0.25-1).  As  the graphics  get  larger  the  effect  of  higher  acceleration diminishes.
Higher acceleration can degrade cut quality.

Curve Quality
This parameter is more important in small graphics than in large labels or text.  Use a setting of 1
for fastest speed and least quality.  Use 16 for best quality and least speed. This parameter does
affect throughput speed on graphics with short vectors. 

Vinyl Anticipation

This a parameter that adjusts the backlash compensation in the cutter.  This parameter used
when  not  in  tangential  emulation  mode.  Heavier  materials  require  more  backlash
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compensation. These numbers are individually set at the factory and should not require
adjustment except when cutting heavy materials. If you are experiencing thick and thin
lines or misshaped letters, adjust the anticipation parameter to obtain satisfactory results.

Load Previous Setup

Loads or saves a custom set-up or power up default. Enter setup # to save.  Setting #1 is 
loaded when the machine is powered up. 

Stencil Settings

Displays the stencil settings menu

Stencil Force

This is the force separation between drag knife mode and
tangential  emulation  cut  mode.  Tangential  emulation  cut
mode is normally used for rubber or very heavy material.
If the set force is above the stencil force stencil mode is
used else drag mode is used. (Default 20 for 3536 and 99
for other cutters)

Scratch Force

This displays and sets the down force used during tangential emulation. This is primarily
used when cutting thick materials such as sandblast rubber. Tangential emulation simulates
a tangential or servo controlled rotating knife by moving to a position short of the vector to
be cut and putting the knife blade down with a very light force while moving toward the
direction of cut to align the knife before applying the full cutting force. This improves the
cut quality in thick materials. (default 0.1%).

Backup Offset

Increasing this value increases the about of dragging the knife does while scratching the
surface of the rubber to align the knife.

Anticipation

This a parameter that adjusts the backlash compensation in the cutter. This parameter used
when the cutter is in tangential emulation mode Heavier materials require more backlash
compensation. These numbers are individually set at the factory and should not require
adjustment except when cutting heavy materials. If you are experiencing thick and thin
lines or misshaped letters, adjust the anticipation parameter to obtain satisfactory results.

Advanced Parameters – Cutting
Advanced parameters require you to select the Settings →
About → User Settings → Menu Settings → 25 → enter.

Cad Override
This menu function enables or disables the CAD override
function.  With the function On the cutter will ignore some
HPGL control commands sent from the cutting software.
With the function Off the CAD software can control these
HPGL commands. Note: sending a job from the DirectCut
cutter  driver  will  turn  cad  override  off  until  cutter  is
restarted.
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The commands affected by Cad override are:

AS set acceleration
FS set force
KA set minimum angle
KN set knife offset
IP input P1/P2
RO rotate
SC set scale
SP select pen
ST select tool
UV up velocity (move speed)
VS down velocity (cut speed)

Minimum Angle

The cutter must stop and then accelerate whenever it makes a sharp turn. At shallow angles
the cutter  can continue at  the cut  velocity  without  decelerating  then accelerating.  This
parameter sets the angle where below which the cutter can continue without stopping. High
values increase throughput and lower value increase quality. Good quality can be obtained
at reasonable speed at the default value of 12°. 

Knife Offset

Knife Offset is the distance between the center of the
knife blade and the knife tip. Standard blades have a
0.013 inch (.033 cm) offset. If you have objects that
do not close correctly,  you might have to adjust the
knife offset to correct the problem. If the corners of
the test pattern (or lettering) have misshaped corners
when knife cutting, adjust the knife offset 

If the blade offset is too high, the corners will be extended
and the circles will have bumps. In that case, reduce the knife offset. For example, if the original 
offset is 0.012 and the output shows signs of too much offset, try an offset of 0.010 (or less).

If the blade offset is too low, the corners will be rounded and the circles will have nicks. In that 
case, try an offset of 0.014 (or more).

If a good test pattern cannot be achieved in this manner, inspect the knife blade and replace as 
necessary.
H20-017 30° Allen Datagraph cutting blade. Ideal for label stock. Angle of blade at 30 degrees to 
have exact control on depth of cut. This blade has a 0.012 inch (0.0305 cm) offset. It can be identi-
fied by its blue plastic cap.

H20-007 45° cutting blade. Ideal for general purpose cutting of vinyl and other thin materials. An-
gle of blade at 45 degrees to balance depth of cutting and pivot angle. This blade has a 0.012 inch 
(0.0305 cm) offset. It can be identified by its red plastic cap.

H20-008 60° cutting blade. Ideal for cutting thick materials. Angle of blade at 60 degrees 
to optimize cut angle. This blade has a 0.012 inch (0.0305 cm) offset. It can be identified 
by its green plastic cap.

Auto Load

This parameter turns on/off the media height sensor. If the sensor is off the cutter can plot in the 
entire area of the carriage movement. If on, the cutter comes up unloaded. After positioning the 
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pinch wheels, You press load to make the cutter ready to receive jobs. The cutter will measure the 
distance between the pinch wheels and only allow cutting between the pinch wheels. This option 
is normally set to On.

Save Setup - 
Adjust force, speed, acceleration as needed. Then touch Save Setup and enter the setup number to
save the settings

Calibration 
Cutter  calibration  for  SmartMark  is  beyond  the
scope  of  this  document.  Please  read  calibration
procedure available on the technical support page of
the  Allen  Datagraph  web  site  at
http://www.allendatagraph.com.   Standard  cutter
calibration  is  described  in  Appendix  I  or  Website
Copy   /   CD Copy

The defined size of a plotter unit is 1/1016 inches or
1/40 mm. This function allows adjusting the number
of encoder counts per inch in the X axis and Y axis.

Cut / Measured

X Cut – Size to cut or that was cut

X Measured – After cutting enter the size you measured

Y Cut – Size to cut or that was cut

Y Measured – After cutting enter the size you measured

Send Cut

Press this after entering x Cut and Y cut sizes.

Update Cal

Press this after entering measured sizes.
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Smartmark Settings

X Registration, Y Registration

 -  The  SmartMark  sensor  is
offset  from  the  center  of  the
knife. The sensor offset distance
is preset at the factory or during
installation, but may need to be
adjusted  on  occasion.  See
drawing for definition of sensor
offsets.  Title:  Calibration
Website Copy / CD Copy.

Job Spacing

This is the distance after the farthest excursion of the
x-axis during a frame that the i-TECH should advance
to find the target in the next frame of labels. This item
is  duplicated  in  the  DirectCut  printer  driver  as  the
space between jobs.  These two parameters are added
together so if the printer driver is normally used. Set
this parameter to 0 To control from cutter driver. Set
cutter driver  to 0 to control from here.  If you have
sent the wrong space between jobs you can adjust the
about +/- 4 inches to correct the error.

Scan Direction

This  sets  the  direction  of  the scanning operation.  For  single mark  origin scanning the
NORMAL target scan direction is +X, +Y. There may be circumstances where it might
be desirable to reverse the scan direction. For instance, the mark might be printed to close
to the trailing edge of the preceding labels limiting the distance available for scanning. In
this instance, it might be desirable to select INVERSE for the scan direction in this axis.
Changing the direction might require adjustment of the X/Y Registration parameters. See
also Website Copy / CD Copy.
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Scan Speed

This  sets  the  speed  of  the  scanning.  Depending  on  the  media  and  registration  mark
contrast, this parameter may need to be adjusted. The better the contrast in reflectivity the
faster the scan velocity can be set. If you are experiencing missed registration marks, you
may need to reduce the scan velocity. 

Advance Settings – Smartmark
Advanced parameters require you to select the Settings → About → User Settings → Menu Set-
tings → 25 → enter.

X Axis Size / Y Axis Size

These parameters are the offset from the exact center
of the red dot of the SmartMark  sensor to the sense
radius and may change based on sensor sensitivity or
media reflectivity. This parameter is best set using the
procedure  in  the  above  TSB.  The  Sensor  Size
parameter  is  only  useful  in  origin  scale  and  three
target scanning. If you are not, these methods you can
set the size to 0.02 and the sensor size is included in
the sensor-offset parameter.

Scan Length

The ideal scan length should be about the dimension of the target mark. When looking for a target 
the machine backs up ½ the scan length before preforming a scan

Scan Offsets

The i-TECH SmartMark  system has adjustable scanning parameters to allow for different
size and style of registration marks.  The primary parameters are the scan offset and length.
The ideal X and Y offsets are one-half the mark size and the ideal scan length is the mark
size. 

To set the parameters type in the desired numbers in
the  X  Scan  Offset,  Y  Scan  Offset and  Scan
Length.  When  you  have  entered  the  desired  values
click on OK. (see also Explanation of SmartMark)

X Scan Offset 

Origin  -  amount  /  direction  to  move  in  x  axis  to
preform the y axis scan

Skew - amount / direction to move in x axis to preform the y axis scan

Scale - amount / direction to move in x axis to preform the y axis scan

Y Scan Offset

Origin - amount / direction to move in y axis to preform the x axis scan

Skew - amount / direction to move in y axis to preform the x axis scan

Scale - amount / direction to move in y axis to preform the x axis scan
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About This Machine 
This display a screen showing the software version and other information about the status
of the cutter.  

User Settings Button

The  user  settings  button  will  allow  changing  parameters  that
customize the settings for the cutter for the menu type, smart mark
settings  enable,  baud  rate,  units  of  measure  and  the  display
language 

Clear Last Error

The last error is saved forever. Clearing this error will allow the de-
termination if the error displayed is new or old.

Set Model Number

Allows setting the model number of the cutter.

User Settings
Menu Settings

This option allows changing from BASIC to ADVANCED. To
change  to  advance  menus  press  button,  press  2,  5,  enter  to
change to advanced mode.

Smart Mark Settings

Most cutter do not have a Smart Mark Sensor.  The SmartMark Set-
tings button allows turning the settings for the Smartmark sensor on
so they can be adjusted.

Baud Rate

Some older versions of software do not support the 460800 baud rate.  If you are using such a pro-
gram select Baud button to change to 9600.

Units

Most measurement setting buttons can be selected to be in either inches or millimeters.  In the US 
you probably will want inches.  The rest of the world will want mm.

Display Language

The display language for the graphic panel can be in Eng-
lish, German, Spanish, of French.  Press the button for de-
sired display language.

Machine Diagnostic
Machine Diagnostics require you to select the Settings →
About → User Settings → Menu Settings → 25 → enter.

8 Default Cal 

This  resets  the  x/y  movement  calibration  to  their
default values

43 Default Settings

resets the cutting parameters and the 6 settings to their
default values
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76 Factory Defaults

Resets  all  the  parameters  that  are  stored  in  the  cutter,
calibration, settings, carriage, etc.  You will have the option of
saving the calibration parameters.

21, 24, 34, 58 Flag & Carriage

Diag 34 flag value

This diagnostic is used to verify the correct flag position
on the  cutting  head.  It  displays  the  knife  height  on  the
display.  The flag is  a small,  flat,  angled piece of  metal
which moves up and down between a pair of circuit board
mounted sensors. The flag is held on to the knife holder by
2 Allen screws, which are loosened slightly if adjustment
is necessary. There are 3 locations the knife holder can be
in. They are:

Bottom (remove the knife from the holder and press the
holder  down  to  the  bottom)  The  display  should  read
between 000 and 006. 

Down (press the knife down with a knife in the holder)
The display should read 020 to 030 pressing down with a
knife in the holder (no media present). Adjust flag position
if necessary.

Top (hold the knife up) The display should read 0100 or more.

The display should change immediately as you move the knife up or down away from top or
bottom positions.

Slightly move the flag to obtain the above reading at each of the three locations.

Check that the flag screws are tight and recheck Bottom and Down.

SmartMark Line Sensor 21

Continuously displays the result of the SmartMark  Line sensor.  When you place a white piece of 
material under sensor a number > 100 should be displayed. When you place a printer black target 
under sensor the reading should be < 20.

Diag 58 – Setup up carriage top and bottom

It is necessary to adjust the flag mechanical position before running diagnostic 58. This diagnostic
configures the carriage to the cutter. It measures the up, down, and bottom position of the knife so
that it can properly raise and lower the knife without punching a hole in the media.

Before starting the diagnostic, joystick to center of travel in the y (left/right) axis.

To run this diagnostic remove the knife holder from the carriage and touch the “Remove Knife and
Press” button.

Next, Replace the knife holder in the carriage and touch the “Replace Knife and Press” button.
Cutter will restart to complete diagnostic.

Reed Switch 24

This diagnostic continuously displays  the result  of the media height sensor. As the reed switch
passes in front of a pinch wheel with a magnet installed, the output will change from Off to On.
Reed switch is used only if media height sensor is turned on.
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Train Background

If you are having problems scanning targets, it could be that the sensor needs to be trained.  To
train  the  sensor,  place  a  white/background  in  front  of  the  SmartMark  sensor  and press  Train
Background.

Train Target

Place the mark in front of the sensor and press, Train Target.

DHCP / Manual

DHCP –  select to use  Dynamic Host Configuration Protocol   to automatically assign the IP
address. Your network must have a DHCP server running to use this option.

Manual – select to use static IP assignment

Custom IP Address – The IP address of the cutter. Default address is 192.168.4.10

Custom  Subnet  Mask  –  The  subnet  mask  of  the  cutter.  Default  subnet  mask  is
255.255.255.0.  Note to communicate via Ethernet the subnet mask should be same for
cutter and network and the cutter and the computer must be on the same sub net.

Installing Knife Blades
Installing replacement blades 

The knife blade should be replaced when the force has been increased by more than 20 percent or
the cut quality has degraded. The first sign of blade degradation usually occurs in the corners of the
cut and may lead to poor weeding. 

New blades slide  into the holder  to a preset  height  and are  held in  magnetically.  No tools or
adjustments are required. To replace the blade, first remove the blade holder from the tool holder
by loosening the brass thumbscrew and pulling up on the silver knife holder. Remove the black
plastic cap. To remove the used blade, grasp it with a pair of tweezers and pull it out of the knife
holder (discard the blade safely).  Remove the new blade from the plastic case and remove the
protective cap. Insert the blade into the holder and let the magnet pull it into the preset position. Put
black cap back on knife holder. Reinsert the knife holder into the tool holder and tighten the brass
thumbscrew. 

Replacement blades are available from Allen Datagraph Systems, LLC. They can be purchased
online @ http://www.allendatagraph.com/ and clicking on the Online Store button, or by calling
603-216-6344. 

H20-017 30° Allen Datagraph cutting blade. Ideal for label stock. Angle of blade at 30 degrees to 
have exact control on depth of cut. This blade has a 0.012 inch (0.0305 cm) offset. It can be identi-
fied by its blue plastic cap.

H20-007 45° Allen Datagraph cutting blade. Ideal for general purpose cutting of vinyl and other 
thin materials. Angle of blade at 45 degrees to balance depth of cutting and pivot angle. This blade 
has a 0.012 inch (0.0305 cm) offset. It can be identified by its red plastic cap.

H20-008 60° Allen Datagraph cutting blade. Ideal for cutting thick materials. Angle of blade at 60 
degrees to optimize cut angle. This blade has a 0.012 inch (0.0305 cm) offset. It can be identified 
by its green plastic cap.

Tool Holder Block
The knife blade holder is installed in the tool holder block with a thumbscrew. The tool holder
block is held to the cutting head by two hex drive screws.
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Knife Blade Holder Assembly
The blade holder is designed for use with Allen Datagraph’s 30°, 45° and 60° blades. Solvents and
lubricants should not be used, as they will diminish cutting accuracy. 

Knife Blades
Knifes  blades  for  the  Allen  Datagraph i-TECH Unit  are  made  with  tungsten  carbide  and  are
designed specifically for digital die cutting. The tip is offset from the center of the shaft so that the
blade has a caster action when pulled. Blades are available in 30, 45 and 60-degree tip angles. The
60-degree is intended only for thick materials such as sandblast mask or thick over-laminates. For
best cutting results, protect the knife tip from damage when not in use. 

Knife Blades Depth Guide
Allen Datagraph's controlled depth knife holder has a depth guide that is adjustable to control the
depth of cut the cutter makes. Correct adjustments allow the blade to cut the material and lightly
mark the backer (carrier) material. Too much cut depth can cause cut through and premature blade
wear. Not enough cut depth will make "weeding" of media difficult. 

Use the cut test, force and depth adjustment to establish good cutting (see setting cut force – cut
depth section)

Use the cut test and force to establish good cutting (see setting cut force – cut depth section)

Cut Strip
Clean any debris from the groove before installing a new cut strip. The strip simply snaps into and
out of place with no special tools required. It is important that the cut strip be installed fully
and evenly, otherwise material cut through may occur in some sections across the cutter. The
cut  strip  should be installed for  knives  and pen plotting,  but  must be  removed for  Pouncing.
Replacement cut strips are available at online store http://allendatagraph.com/. Select Online Store
and cutter supplies to see available cut strips.

Maintenance
Cleaning

The regularity with which the cutter needs to be cleaned is dependent on the usage, as well as the
climate  and  contaminants  in  the  cutter’s  environment.  It  is  recommended  that  the  following
cleaning steps be done at least as often as indicated for each procedure:

1. Biweekly. Clean the three grit wheel surfaces with a stiff bristled e.g. tooth (not wire)
brush to remove any media particles that may have built up during cutting. Brush the
surface of the grit wheel while turning the grit wheel by hand so the entire surface of
the grit wheel is cleaned. CAUTION: Be sure to disconnect the cutter from the power
source while cleaning the unit. Keeping the grit wheel clean is important so the cutter
will hold the media accurately.

2. Biweekly. Wipe media-related dust from the set of polyurethane pinch wheels by using
a soft cloth.

3. Monthly. The outer surfaces should also be kept clean. If necessary, a mild cleaning
solution on a damp cloth can be used to gently wipe the surfaces clean. It is suggested
that a mild soap and water be used with a soft cloth. This solution works well on all
painted surfaces. CAUTION: Do not use any abrasive cleaners, as they will cause the
paint to blister.

4. Yearly.  Inspect the internal circuit board assemblies and clean accumulated dust as
necessary.  Be  certain  that  the  cutter  power  is  off.  Observe  static  discharge  safety
procedures that may damage sensitive electronic components. Wear a grounding strap
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connected to earth ground. Wear safety glasses to protect eyes. Remove front and side
covers and use compressed air to remove dust and debris. Replace cover to original
location and make certain that that any connectors are well seated.

Pinch Wheel Maintenance
Pinch wheels  are  critical  to  the  i-TECH unit's  material  handling performance.  They should be
inspected for wear regularly and cleaned as needed. To clean adhesive off the pinch wheels, simply
use a soft cloth and denatured alcohol.

In normal use, the pinch wheels will need to be replaced in time. Also, trying to move them when
they are in the down position can damage them. If material does not track well and guide alignment
has been verified, the pinch wheels may need to be replaced. For best tracking results, replacement
pinch wheels should be replaced as a SET. 

To check condition of pinch wheels:
1) Inspect condition of rubber The rubber wheel should not have any cracks and should be

securely adhered to the aluminum hub of the wheel. The transition from the flat surface of the
wheel to the "sidewall" edges of the wheel should be sharp and not rounded.

2) Inspect integrity of pinch wheel bearing This is done by having the pinch wheels in the up
position. Spin wheel with finger and observe whether the bearing has a dry sound or not. If it
appears to be dry, the wheels should be replaced.

Mechanical Adjustments
Belt Tension

The i-TECH servomotors  use  timing  belts  to  control  the  material  (X axis)  and  tool  (Y axis)
positions. The belt tension and wear should be inspected if cut quality deteriorates. To inspect the
belts, remove the pods at either end of the i-TECH. This can be done by removing about 16 screws
along the edge of the pod covers. You can operate the cutter with pods installed in the extended
position by reinstalling the pods using two screws.  (see also TSB:  Mechanical  Adjustments  to
Restore Cut Quality Website Copy / CD Copy)

Y-Axis
The Y-axis short belt runs between the Y-axis servomotor and a gear assembly under the left hand
pod. To adjust the tension of this belt, it is necessary to reposition the motor bracket. 

1. Loosen the three Phillips head motor bracket screws and apply hand pressure to
tighten the belt so that the belt  will  deflect 0.050 inches at the center when 23
ounces are applied. (1.3 mm when 660 grams are applied). 

2. When the belt is tight and the motor shaft is parallel to the bearing shaft, tighten
the three Phillips head motor bracket screws. Premature belt failure will occur if
these two shafts are not parallel.

3. Verify tension.

The long belt is adjusted using a lead screw located behind the control panel. To set the long belt's
tension:

1. Position the carriage to about 24 inches from one end.

2. Remove the control panel housing as follows

a. Install the right pod at extended position as described above.

b. Remove the top rail cover over the carriage by removing the two screws at
each end of the cover.
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3. Loosen locking nut. Adjust the lead screw so that the 24" of belt when plucked like a
guitar string vibrates at a low base note. It should not flop around and stop oscillating
immediately.

4. Set the lead screw lock nut.

5. Verify belt path and tension.

6. Replace the control panel housing, top rail cover and rear cover.

X-Axis
The belt inside the rear cover drives the grit wheel (X axis). To adjust the tension of this belt, it is
necessary to reposition the motor. 

1. Loosen the two motor bracket screws and apply hand pressure to tighten the belt so
that the belt will deflect 1/16 inch at the center when 23 ounces are applied. (2 mm
when 660 grams are applied). (Replace belt if damaged or worn). 

2. When the belt is correctly tensioned, tighten the two motor bracket screws.

3. Verify belt path and tension. Check that the large gear turns freely.

Trouble Shooting
Problem Solutions

Cutter does nothing  Panel  lights  off,  no  fan  noise  :  plugged  in,  power  on,  cycle
power

 On Hot tip units check fuse in power entry module. Replace with
one 5A fuse for 115 vac or two 2.5A fuses for 220 vac.

Cut through/poor weeding  Is your knife blade sharp? You can check condition of blade by
examining the blade tip under a 30x microscope. The blade tip
must be present.

 For very thin (less than 0.002 inch, (0.05 mm)) or liner less than 
20 lb. media you might need to use the controlled depth 
adjustment on the end of the knife holder. Partially unscrew the 
black cap until just enough knife blade is exposed to cut through 
the media but not the backer. Test by drawing knife across 
media by hand. You can then use a higher force with no cut 
through.

 It is important that the groove filler be installed fully and evenly,
otherwise material cut through may occur in some sections 
across the cutter.

 Insufficient backer weight.

 Check mechanical adjustments Website Copy / CD Copy

 Increase / Decrease force. Increase decrease knife offset.

 Check cut strip condition. Replace or reverse if damaged.

 Decrease acceleration or speed.

 Increase resolution in printer driver.
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 Do not allow cutter motors to pull media off of roll.

 Using wrong angle of blade for material.

Images are incorrect size  If error is small (< 1/2 inch (12 mm)) make sure grit wheel is
clean. Dirt build up in grit will change the size of the grit wheel
making it cut the wrong size. Run diagnostic 07 to calibrate the
cutter to a ruler. 

 If error is large (10% or more) then you probably have wrong
model  number  in  cutter  or  mismatched  AllenCad  and printer
driver  versions.  Model  numbers  for  template  maker  and
Magnetic sign cutters are in the 2000 range. GT cutters do not
have 2000 added to model  number.  Check the model  number
displayed on the remote panel setup -> main menu.

 Template cuts off by small amounts or different amounts each
time. Website Copy / CD Copy

Contour  cuts  are  wrong
size.

 If you are using origin only or origin skew no scaling is done to
image received. In this case you must calibrate the cutter to your
printer  rather  than  a  ruler.  You  do  this  by  printing  a  large
rectangle on your printer. Then cut the same size rectangle. For
x and y drawn use printed size rather than a ruler as drawn or
desired size.

 If you are using origin scale, or origin skew scale then the size of
the cut is change by the x or y sensor size parameter in the line
sensor menu. See Smart Mark Setup section.

Labels or contour cuts are
cutting in the wrong spot

 Verify you created job correctly.

 Origin target is at minimum x and maximum y of drawing.

 The scan area contains only target and background with no stray 
marks that could be seen as targets.

 Verify printer properties are correct

 Rotation is set correctly. Target cut should be in same corner on 
preview as selected origin corner.

 Find origin property is set to Origin only or other advanced op-
tion.

 Verify sensor settings have not been lost in the remote panel se-
lect setup -> line sensor menu.

 Verify x sensor offset is about 0.75 inch and y sensor offset is 
about –0.1 inch

 If your job is off by only a little bit (less than 1/8 inch (3mm)) 
and is same for every frame you can measure this error and cor-
rect your x and y sensor offset by the amount of the error you 
measure.

 Verify scan length is the same as the length of the side of the tar-
get

 Verify the scan offsets = ½ of the length of the side of the target

 Verify the Scan Velocity is either 1 or 2.
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 Verify the space between jobs in the line sensor menu is zero.

 Verify Skew target is at minimum x, maximum y of artwork.

 Verify Scale target is at maximum x, minimum y of artwork. 

Target errors tar1, tar2, 
tar3, tar4

 These errors indicate that the target scanner did not find the tar-
get.

 If Target Error Origin on first frame:

o Verify that you positioned red led pointer to right rear 
corner of target

o Verify red led is lit.

o Check that distance led is from media is 3.4 to 4.6 mm.

o Run line sensor diagnostic (21) to verify operation of 
sensor.

 If Target Error on subsequent frame

o Verify space between jobs in printer driver is set cor-
rectly. If it is set correctly after cutting first frame the 
knife blade should be on the right rear corner of target of
next frame.

 Target Error Skew, Scale, Rotate.

o Verify job you are sending matches job you printed

o Verify rotation is correct in printer driver

o Verify job is built correctly in that scale and skew target 
print is in same location is die lines for scale and skew 
target.

o Verify scale and skew targets are at extents of image. 
Skew should be a minimum x and maximum y. Scale 
target should be at maximum x and minimum y.

Composer spools out lots 
of material before cutting 
image

 When using direct cut driver and sending from Gerber software,
if the cutter spools out lots of material instead of cutting where it
is,  go  to  file,  print,  select  Allen  device,  click  options  tab,
uncheck HEADER box, click preferences button.

No action when you send 
data to cutter

 Allen Spooler: If plot is sent from computer and cutter doesn’t
cut,  check  for  Allen  spooler  in  the  task  bar  (Lower  right  of
monitor, green box with red arrow, near time). If it is not there,
go to start button, programs (all programs), startup, allen spooler
and  click  on  allen  spooler.  If  you  get  message  saying  allen
spooler starting with one job left in queue, cancel it and send job
again after checking to see that cutter is ready.

 Click on red arrow in green field icon in service icon area. If you
are getting unable to open port displayed 

 See if remote panel still has port open. It should auto close the
port after 5 seconds.

 Reboot computer and cutter.

 Verify port  selected  is  correct.  You can  find  the  correct  port
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from the device manager.

 Plug usb cable into same usb port as you normally do. Different
usb holes are normally configured as different com ports.

 Rerun enable printer driver to find cutter. Start > All Programs >
Allen Datagraph > Cutter Driver > Enable printer driver

 Try different usb cable or different computer.

 From spooler cancel all jobs, turn cutter off/on and resend job.

 No usb driver installed for equipment Website Copy / CD Copy

 Cutter in pause state.

Job does not complete  Verify minimum cutter driver level of 3.0. New software can be 
downloaded from Web Site Copy

 If you have less the firmware revision 12 as usb version in your 
cutter turn off polyline encoded output in printer properties, de-
vice settings. Web Site Copy / CD Copy

 Try a different cable or computer

When I turn my cutter on,
the head reaches the side 
plate and makes a loud 
noise

 Loose long Y belt

if carriage is getting to the right side and making a ratcheting 
noise, it's could be the long y axis belt, or the y axis motor belt 
located under the left control panel. To determine which belt it 
is, turn the machine on while holding out on the long belt that at-
taches to the cutting head. What this does is put more tension on 
the belt. If the head gets to the side and they don't hear the noise,
proceed to below: 

Remove the control panel and locate the belt tensioner. This is a 
wedge-shaped device with a long Phillips head screw protruding
toward the rear of the machine.

Loosen the 3/8" locking nut holding the tensioner screw in place.
Turn the phillips screw a couple turns clockwise, then turn the 
cutter on before attaching the control panel. If the cutter initial-
izes, there is no need to look further. If this does not solve the 
problem, proceed to the next step: 

Open rear cover, turn cutter on and observe the belt attached to 
the motor. If the motor pulley continues to turn, then the short 
motor belt is most likely either loose or worn out. Carefully in-
spect the teeth on the belt for wear with the machine off. The 
pulley can be rotated to allow inspection of teeth.

 If the teeth are not worn or stripped off the belt, loosen the three
mounting  screws  holding  the  motor  bracket  to  the  sideplate.
Apply tension to the motor bracket BY HAND, and tighten the
screws. The belt should have less than 1/8” of free play when
properly tightened.

Media sensors can’t see 
black EC film or vinyl 
with clear backer. 

 Turn off paper sensors using setup -> options in remote panel.

 Cover 1/2 the sensor hole with masking tape.

Router keeps changing  Some routers do not keep a table of mac addresses so that the 
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my ip address same computer will be assigned same ip address each time you 
power up. In this case Set advanced menu mode, home parame-
ters – Machine diagnostics. Set DHCP/Manual to Manual.and 
assign a static ip address to the cutter. See also Website Copy   / 
CD Copy

Material Does not track 
straight

 Tracking video Website Copy   /   CD Copy

 Instructions for adjusting donuts on tracking guides Website 
Copy / CD Copy

 Move pinch wheels out of punched area.

 Do not allow cutter to pull media off of roll.

 Inspect pinch wheels

 Clean grit wheel and pinch wheels.

 Reduce acceleration and / or velocity.

 Change springs Web Site Copy or CD Copy.
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Error Codes
If the internal microprocessor detects an error condition, the letter E0 and a 2 digit code will be
displayed on the control panel. Any key pressed after the error is displayed will place the machine
in the diagnostic mode, indicated by a flashing "D" on the control panel. Recommended diagnostic
procedures (D##) are listed in the error description.

The mmc software error codes are in the following linked doc-
ument. Web Site Copy / CD Copy. You can recognize the
mmc machines by looking at the communication port. If your
port looks like this use this link to error codes.

Appendix A Installation And Assembly Instructions
Website Copy / CD Copy

Appendix B SmartMark Setup
Website Copy 

Appendix C Loading
Model 536

Website Copy / CD Copy

Model 830, 836, 848, 860 
Website Copy / CD Copy

Appendix D Cart Assembly Instructions
Website Copy / CD Copy
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Appendix E Radio and Television Interference 
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable pro-
tection against harmful interference when the equipment is operated in a commercial environment. 
This equipment generates, uses and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communi-
cations. Operation of this equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at his own expense.

In order to maintain compliance with FCC regulations shielded cables must be used with this 
equipment. Operation with non-approved equipment or unshielded cables is likely to result in inter-
ference to radio & television reception.

This device complies with part 15 of FCC Rules. Operation is subject to the following two 
conditions; (1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.

Appendix F Model i-536 Addendum
Website Copy / CD Copy

Appendix G Model i-536 Adjustable Parameters
Website Copy / CD Copy

Appendix H Hot Tip Instructions
Website Copy / CD Copy

Appendix I Template Maker Supplement
Website Copy / CD Copy
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